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Important safety information
This manual contains information and warnings that must be followed by the user for safe operation and to keep the product in a
safe condition.

To safely perform service on this product, see the Service safety summary that follows the General safety summary.

General safety summary
Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product or
any products connected to it. Carefully read all instructions. Retain these instructions for future reference.

This product shall be used in accordance with local and national codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition to
the safety precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or adjustment.

Before use, always check the product with a known source to be sure it is operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use. Do not use the
provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric shock, the
grounding conductor must be connected to earth ground. Before making connections to the input or output terminals of the
product, ensure that the product is properly grounded. Do not disable the power cord grounding connection.

Power disconnect. The power cord disconnects the product from the power source. See instructions for the location. Do not
position the equipment so that it is difficult to operate the power cord; it must remain accessible to the user at all times to allow for
quick disconnection if needed.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are connected to a voltage
source. Use only insulated voltage probes, test leads, and adapters supplied with the product, or indicated by Tektronix to be
suitable for the product.

Observe all terminal ratings. To avoid fire or shock hazard, observe all rating and markings on the product. Consult the product
manual for further ratings information before making connections to the product. Do not exceed the Measurement Category
(CAT) rating and voltage or current rating of the lowest rated individual component of a product, probe, or accessory. Use caution
when using 1:1 test leads because the probe tip voltage is directly transmitted to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

Do not float the common terminal above the rated voltage for that terminal.

Do not operate without covers. Do not operate this product with covers or panels removed, or with the case open. Hazardous
voltage exposure is possible.
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Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by qualified
service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of the
product, turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged. Do not use
probes or test leads if they are damaged, if there is exposed metal, or if a wear indicator shows.

Examine the exterior of the product before you use it. Look for cracks or missing pieces.

Use only specified replacement parts.

Use proper fuse. Use only the fuse type and rating specified for this product.

Do not operate in wet/damp conditions. Be aware that condensation may occur if a unit is moved from a cold to a warm
environment.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean the product.

Provide proper ventilation. Refer to the installation instructions in the manual for details on installing the product so it has
proper ventilation.

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects into
any of the openings.

Provide a safe working environment. Always place the product in a location convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use may
result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress injuries.

Use only the Tektronix rackmount hardware specified for this product.

Probes and test leads
Before connecting probes or test leads, connect the power cord from the power connector to a properly grounded power outlet.

Keep fingers behind the protective barrier, protective finger guard, or tactile indicator on the probes.

Remove all probes, test leads and accessories that are not in use.

Use only correct Measurement Category (CAT), voltage, temperature, altitude, and amperage rated probes, test leads, and
adapters for any measurement.
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Beware of high voltages. Understand the voltage ratings for the probe you are using and do not exceed those ratings. Two
ratings are important to know and understand:

■ The maximum measurement voltage from the probe tip to the probe reference lead

■ The maximum floating voltage from the probe reference lead to earth ground

These two voltage ratings depend on the probe and your application. Refer to the Specifications section of the manual for more
information.

WARNING. To prevent electrical shock, do not exceed the maximum measurement or maximum floating voltage for the
oscilloscope input BNC connector, probe tip, or probe reference lead.

Connect and disconnect properly. Connect the probe output to the measurement product before connecting the probe to the
circuit under test. Connect the probe reference lead to the circuit under test before connecting the probe input. Disconnect the
probe input and the probe reference lead from the circuit under test before disconnecting the probe from the measurement
product.

Connect and disconnect properly. De-energize the circuit under test before connecting or disconnecting the current probe.

Connect the probe reference lead to earth ground only.

Do not connect a current probe to any wire that carries voltages or frequencies above the current probe voltage rating.

Inspect the probe and accessories. Before each use, inspect probe and accessories for damage (cuts, tears, or defects in the
probe body, accessories, or cable jacket). Do not use if damaged.

Ground-referenced oscilloscope use. Do not float the reference lead of this probe when using with ground-referenced
oscilloscopes. The reference lead must be connected to earth potential (0 V).

Service safety summary
The Service safety summary section contains additional information required to safely perform service on the product. Only
qualified personnel should perform service procedures. Read this Service safety summary and the General safety summary
before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this product unless another person capable of rendering
first aid and resuscitation is present.

Disconnect power. To avoid electric shock, switch off the product power and disconnect the power cord from the mains power
before removing any covers or panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist in this product. Disconnect power, remove
battery (if applicable), and disconnect test leads before removing protective panels, soldering, or replacing components.

Verify safety after repair. Always recheck ground continuity and mains dielectric strength after performing a repair.

 Important safety information
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Terms in the manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Terms on the product
These terms may appear on the product:

■ DANGER indicates an injury hazard immediately accessible as you read the marking.

■ WARNING indicates an injury hazard not immediately accessible as you read the marking.

■ CAUTION indicates a hazard to property including the product.

Symbols on the product

When this symbol is marked on the product, be sure to consult the manual to find out the nature of the potential
hazards and any actions which have to be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbols may appear on the product:
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Preface
This manual provides product safety and compliance information, describes how to connect and power on the oscilloscope, and
introduces the basic instrument features, controls, and operations. See the product Help file for more detailed information.

Key features
Welcome to the 3 Series MDO. The 3 Series MDO Oscilloscopes (MDO32 and MDO34) are 2- and 4-channel oscilloscopes,
enabling you to efficiently and cost-effectively perform mixed domain debugging.

■ A dedicated RF input channel for frequency domain measurements

■ Bandwidths from 100 MHz to 1 GHz

■ 2- and 4-channels for time domain measurements

■ Sixteen-channel digital input option

■ Large 11.6” HD (1920 x 1080 pixel) capacitive touchscreen display

■ User interface optimized for touchscreen use

■ Sample rates of 2.5 GS/s on all analog channels (5 GS/s on 1 or 2 channels for the MDO34 or MDO32 with the 1 GHz
option)

■ 10 M points record length on all channels

■ Maximum waveform capture rate: 280,000 waveforms/second, with FastAcq: >50,000 waveforms/second with normal
operation

■ Advanced triggering and analysis: I2C, SPI, USB 2.0, CAN, CAN FD, LIN, FlexRay, RS-232, RS-422, RS-485, UART, I2S,
Left Justified (LJ), Right Justified (RJ), TDM, MIL-STD-1553, ARINC429 (with the appropriate option), and Parallel

■ Power analysis (optional)

■ Arbitrary function generator and 16 digital channels (optional)

■ Digital voltmeter and trigger frequency counter free with product registration
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Related documents
Use the related documents for more information on instrument functions, how to remotely program or operate the instrument,
understand theory of operation, replace suspected modules, and other tasks.

MDO34, MDO32 documents

To learn about Use this document
How to use instrument
functions

3 Series MDO (MDO34, MDO32) Installation and Safety Manual (This document, Tektronix part
number 071-3608-xx); standard accessory with the instrument. Single document with English,
Japanese, and Simplified Chinese languages.
 
3 Series MDO Help (Printable version of the instrument Help that contains context-sensitive
descriptions of all instrument functions; available at www.tek.com/downloads)

How to remotely control the
instrument

3 Series MDO Programmer Manual (Tektronix part number 077-1498-xx; available at
www.tek.com/downloads)

Instrument specifications and
procedures to verify the
instrument meets
specifications

3 Series MDO (MDO34, MDO32) Specifications and Performance Verification Technical
Reference (Tektronix part number 077-1499-xx; available at www.tek.com/downloads)

Instrument theory of operation,
troubleshooting, disassembly,
and replaceable parts

3 Series MDO (MDO34, MDO32) Service Manual (Tektronix part number 077-1500-xx;
available at www.tek.com/downloads)

Installing the instrument in a
rack

RM3 Rack Mount Kit Instructions (Tektronix part number 071-3609-xx; available at
www.tek.com/downloads)
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Installing your instrument

Check shipped accessories
Make sure that you received everything you ordered. If anything is missing, contact Tektronix Customer Support. In North
America, call 1-800-833-9200. Worldwide, visit www.tek.com to find contacts in your area.

Check the packing list that came with your instrument to verify that you have received all standard accessories and ordered
items. If you purchased factory options, tap Help > About to confirm that the option(s) are listed in the Installed Options table.

Standard accessories

Item Quantity Tektronix part number
3 Series MDO (MDO34, MDO32) Installation and Safety Manual 1 071-3608-xx
Passive Voltage Probe, depends on instrument bandwidth
    (350 MHz, 500 MHz, and 1 GHz bandwidth)
    (100 MHz and 200 MHz bandwidth)

One per analog channel  
TPP0500B
TPP0250B

Accessory bag 1 016-2144-xx
Power cord 1 Depends on region
Calibration certificate 1 N/A
OpenChoice® Desktop Software (available for download from www.tek.com/
software/downloads.)

Safely rotate the handle
Use the correct process to eliminate the chance of pinching your thumb or rear-panel-connected cables while rotating the handle.

CAUTION. Hold the top of the handle to rotate the handle on the instrument. Do not hold the handle from the sides and rotate, as
this can pinch the base of your thumb between the handle and the case.

If you have routed any cables between the handle and the case, be careful when rotating the handle so that you do not pinch the
cables.
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Operating requirements
Use the oscilloscope within the required operating temperature, power, altitude, and signal input voltage ranges to provide the
most accurate measurements and safe instrument operation.

Environment requirements

Characteristic Description
Operating temperature -10 °C to +55 °C (+14 °F to +131 °F)

 
For proper cooling, keep the sides and rear of the instrument clear of obstructions for
2 inches (51 mm).

Operating humidity 5% to 90% relative humidity (% RH) up to +40 °C (+104 °F), Noncondensing.
 
5% to 60% RH above +40 °C up to +55 °C (+104 °F to +131 °F), Noncondensing.

Operating altitude Up to 3000 meters (9842 feet)

Power requirements

Characteristic Description
Power source voltage 100 V - 240 VAC RMS, ±10%, single phase
Power source frequency 50/60 Hz, 100-240 V

 
400 Hz ±10% at 100 to 132 V

Input signal requirements
Keep the input signals within allowed limits to ensure the most accurate measurements and prevent damage to the analog and
digital probes or instrument.

Make sure that input signals are within the following requirements.

Table 1: Maximum analog input

Input Description
Analog input channels, 1 M Ω setting, maximum
input voltage at BNC

300 VRMS
 
Measurement Category II
De-rate at 20 dB/decade between 4.5 MHz and 45 MHz, De-rate 14 db
between 45 MHz and 450 MHz. Above 450 MHz, 5 VRMS.

Analog input channels, 50 Ω setting, maximum
input voltage at BNC

5 VRMS with a peak at ±20 V. (DF ≤ 6.25%).

RF input maximum input voltage Average Continuous Power: +20 dBm (0.1 W)
DC maximum before damage: ±40 VDC
Max no damage +33 dBm (2 W) CW
Peak Pulse Power: +45 dBm (32 W)
Peak Pulse Power defined as <10 μs pulse width, <1% duty cycle, and
reference level of ≥ +10 dBm
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Table 2: Maximum input with a P6316 Digital Probe

Input Description
Threshold Accuracy ±(100 mV + 3% of threshold setting after calibration)
Threshold Range +25 V to –15 V
Maximum nondestructive input signal to probe +30 V to -20 V
Minimum signal swing 500 mVpeak-to-peak

Input resistance 101 kΩ
Input capacitance 8.0 pF typical
Pollution Degree 2, indoor use only
Humidity 5% to 95% relative humidity

Secure (lock) the oscilloscope
Lock an oscilloscope to a test bench or equipment rack to prevent property loss.

Attach a standard laptop security lock to the rear panel of the oscilloscope, to secure the oscilloscope to a workbench, rack, or
other location.
 

 

 Installing your instrument
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Powering the oscilloscope
Use this procedure to connect the oscilloscope to line power and power on and off the oscilloscope. Always connect the
oscilloscope to AC power using the power cord that shipped with the instrument.

Prerequisite: Use the AC power cord that shipped with your oscilloscope.

1. Connect the supplied power cord to the oscilloscope power connector.

Figure 1: Power cord connector and power standby switch

 

2. Connect the power cord to an appropriate AC mains source.
Power is supplied to the power supply and some other boards whenever the AC power cord is connected to a live mains
circuit, putting the instrument in standby mode.

3. Push the front panel power button to power the instrument on and off.
The power button color indicates instrument power states:

Unlit – no AC power applied

Yellow – standby mode

Blue – powered on

4. To completely remove power from the instrument, disconnect the power cord.

Installing your instrument  
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Check that the oscilloscope passes power-on self tests
Power-on self tests verify that all oscilloscope modules are working correctly after power up.

1. Power on the oscilloscope and wait until the oscilloscope screen appears.

2. Select Utility > Self Test from the top-edge Menu bar to open the Self Test configuration menu.

3. Check that the status of all power-on self tests are Passed.

If one or more power-on self tests shows Failed:

a. Power cycle the oscilloscope.

b. Tap Utility > Self Test. If one or more power-on self tests still shows Failed, contact Tektronix Customer Support.

Connecting probes
Probes and cables connect the oscilloscope to your device under test (DUT). Use a probe that best matches your signal
measurement needs.

 
Figure 2: Connecting probes to the instrument

1. Tektronix Versatile Probe Interface (TekVPI)

These probes support two-way communication with the oscilloscope through on-screen menus and remotely through
programmable support. The remote control is useful in applications like ATE where you want the system to set probe
parameters.

2. Tektronix Versatile Probe Interface (TekVPI) for Passive Probes

These probes build upon the functionality of the TekVPI interface. Each probe is matched with its corresponding
oscilloscope channel, allowing the oscilloscope to optimize the signal input path. This provides AC compensation across the
frequency band.

 Installing your instrument
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3. TPA-BNC Adapter

The TPA-BNC Adapter allows you to use TEKPROBE II probe capabilities, such as providing probe power and passing
scaling and unit information to the oscilloscope.

4. BNC Interfaces

Some of these use TEKPROBE capabilities to pass the waveform signal and scaling to the oscilloscope. Some only pass
the signal and there is no other communication.

5. Logic Probe Interface

The P6316 probe provides 16 channels of digital (logical one or zero) information.

6. The TPA-N-VPI Adapter allows you to use TekVPI probes with the RF input.

Connect TPP0250, TPP0500B, TPP1000, TekVPI+, TekVPI, or other supported Tektronix analog probes by pushing them into
an input connector. The probe base latch locks with a 'click' when the probe is fully seated.

TekVPI probes automatically set the channel input parameters for that probe (bandwidth, attenuation, termination, and so on). If
a probe has a Menu button, push that button to open an on-screen configuration menu. Follow instructions provided with active
probes to set their parameters (auto zero, degauss, and so on).

Connect a BNC probe or cable by pushing it onto a channel BNC bayonet connector and turn the lock mechanism clockwise until
it locks.

For more information on the many probes available for use with 3 Series MDO oscilloscopes, visit the Oscilloscope Probe and
Accessory Selector Tool on the Tektronix website at www.tektronix.com.

NOTE. Connecting a probe does not automatically enable that channel (make it active). Use the instrument controls or
programmatic interface to turn on a channel and open its configuration menu to verify or change probe or cable settings
(bandwidth, attenuation, termination and so on).

Rackmount information
The optional RM3 Rackmount Kit lets you install the oscilloscope in standard equipment racks. The rack mount requires six rack
units (6U) of space to install.

Contact Tektronix Customer Support to purchase the rackmount kit option RM3. Follow the instructions that come with the
rackmount kit (RM3 Rackmount Kit Instructions, Tektronix part number 071-3609-xx).

Make sure to allow at least two inches of clearance on the sides for air ventilation and on the back for any cables you attach to
the rear panel.

Installing your instrument  

6  MDO32, MDO34 Installation and Safety Manual

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Remote access from a Web browser
You can remotely access your network-connected instrument from a Web browser to display the instrument user interface on a
PC.

This procedure describes how to remotely access the UI controls and screen for the instrument.

Prerequisites:

■ The oscilloscope must be connected to, and accessible from, the network to which the PC is connected. See Connect to a
network (LAN) on page 34

■ Determine the IP address of the oscilloscope that you want to access. To determine the oscilloscope's IP address, select
Utility > IO in the oscilloscope menu bar and view the network settings in the LAN panel.

1. Open a Web browser on a PC connected to the same network as the oscilloscope.

2. Enter just the oscilloscope IP address on the URL line of the browser and press Enter. For example: 135.62.88.157. The
browser searches for and opens the Web page for the oscilloscope.

Connect the oscilloscope to a PC using a USB cable
Use a USB cable to connect the oscilloscope directly to a PC for remote instrument control.

1. On the oscilloscope, select Utility > I/O from the menu bar.

2. Tap USB Device Port.

3. Confirm that the USB Device Port control is On (default setting).

4. Connect a USB cable from the PC to the USB Device port on the rear of the instrument.

5. If using the USB connection to remotely control the oscilloscope using GPIB commands, set the GPIB Talk/Listen Address
for your configuration (0 - 30).

Cleaning
Use a dry, soft cotton cloth to clean the outside of the unit. If any dirt remains, use a cloth or swab dipped in a 75% isopropyl
alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do not use any liquid cleaning agents or
chemicals that could damage the touchscreen, case, controls, markings or labels, or possibly infiltrate the case.

 Installing your instrument
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Getting acquainted with your instrument
The following content provides a high-level description of the instrument controls and user interface.

Refer to the instrument help for detailed information on using the controls and user interface to display waveforms and take
measurements.

Front panel controls and connectors
The front panel controls provide direct access to key instrument settings such as vertical, horizontal, trigger, and cursors. The
connectors are where you input signals with probes or cables or insert USB devices.

Figure 3: 3 Series MDO controls

   

 

 

 

 

 

 

 

 

MDO32, MDO34 Installation and Safety Manual 9

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



 

1. Acquisition and Cursors controls:
 

 

■ Run/Stop starts and stops waveform acquisition. The button color indicates the acquisition status (green = running and
acquiring; red = stopped). When stopped, the oscilloscope shows waveforms from the last completed acquisition. The
Run/Stop button on the screen also shows the acquisition status.

■ Cursors button turns cursors on or off. Use the Multipurpose knobs to move the cursors. Double-tap the cursor
readouts or on a cursor bar (line) to open the configuration menu to set cursor types and functionality.

■ Fast Acq™ enables or disables the fast acquisition mode. FastAcq provides high-speed waveform capture that
reduces the dead time between waveform acquisitions, enabling the capture and display of transient events such as
glitches and runt pulses. It is helpful in finding elusive signal anomalies. Fast acquisition mode can also display
waveform phenomena at an intensity that reflects their rate of occurrence.

■ Single/Seq enables making a single waveform acquisition, or a specified number of acquisitions (as set in the
Acquisition configuration menu). Pushing Single/Seq turns off Run/Stop mode and takes a single acquisition. The
button color indicates the acquisition status (quick green flash = single acquisition acquired; solid green = waiting for
trigger event). Pushing Single/Seq again takes another single acquisition.

■ High Res mode calculates the average of all the samples for each acquisition interval. High Res provides a higher-
resolution, lower-bandwidth waveform.

■ Clear deletes the current acquisitions and measurement values from memory.

2. Multipurpose knobs:
 

 

■ Multipurpose knobs (A, B) Multipurpose knobs A and B move cursors and set parameter values in configuration
menu input fields. Selecting a menu field that can use a Multipurpose knob assigns the indicated knob to change the
value in that input field. The ring around each knob lights when you can use that knob to do an action.

Push a Multipurpose knob to enable the Fine mode for making smaller increment changes. Push the knob again to exit
Fine mode.

NOTE. If you have a mouse attached, pressing the mouse wheel toggles between Coarse and Fine adjustments.
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3. Trigger controls:
 

 

■ Force forces a trigger event at a random point in the waveform and captures the acquisition.
■ Level sets the amplitude level that the signal must pass through to be considered a valid transition. The color of the

Level knob indicates the trigger source except for dual-level triggers. The Level knob is disabled when the trigger type
requires two level settings or other trigger qualifiers (set from the Trigger configuration menu). Push the knob to set the
threshold level to 50% of the peak-to-peak amplitude range of the signal.

■ Slope sets the signal transition direction to detect for a trigger (low to high, high to low, or either direction). Push the
button to cycle through the selections. The Slope button is disabled when the trigger type requires other slope
qualifiers (set from the Trigger configuration menu).

■ Mode sets how the instrument behaves in the absence or presence of a trigger event:

■ Auto trigger mode enables the instrument to acquire and display a waveform whether or not a trigger event
occurs. If a trigger event occurs, the instrument displays a stable waveform. If a trigger event does not occur, the
instrument forces a trigger event and acquisition and displays an unstable waveform.

■ Normal trigger mode sets the instrument to acquire and display a waveform only when there is a valid trigger
event. If no trigger occurs, the last waveform record acquired remains on the display. If no last waveform exists,
no waveform is displayed.
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4. Vertical controls:
 

 

■ Position moves the selected waveform up or down on the screen. The color of the Position knob indicates which
waveform the knob is controlling. Push the knob to center the waveform handle on the display.

■ Scale sets the amplitude units per vertical graticule division of the selected waveform. The scale values are shown on
the waveform badge. The color of the Scale knob indicates which waveform the knob is controlling.

■ Channel buttons turn on (display), select, or turn off a channel, as follows:

■ If the channel is not displayed, pushing a Channel button turns on that channel in the Waveform view.
■ If the channel is on the screen and is not selected, pushing that channel's button selects that channel.
■ If the channel is on the screen and is also selected, pushing that channel's button turns that channel off (removes

it from Waveform view).
■ The Math button adds or selects a Math waveform on the Waveform view, as follows:

■ If no Math waveform exists, pushing the Math button adds a Math waveform to the Waveform view and opens the
Math configuration menu.

■ If a Math waveform is displayed but not selected, pushing the button selects the Math waveform.
■ If a Math waveform is displayed and selected, pushing the button turns off the Math waveform (removes it from

Waveform view). Push the button again to display the waveform.
■ The Ref button adds or selects a Reference (saved) waveform on the Waveform view, as follows:

■ If no Reference waveform exists, pushing the Ref button opens the Browse Waveform Files configuration menu.
Navigate to and select a waveform file (*.isf) and tap Recall to load and display the reference waveform.

■ If only one Reference waveform is displayed, pushing the button turns off the Reference waveform (removes it
from the Waveform View). Push the button again to display the waveform.

■ If two or more Reference waveforms are displayed, pushing the button cycles through selecting each Reference
waveform.

■ The Bus button adds or selects a bus waveform on the Waveform view, as follows:

■ If no Bus waveform exists, pushing the Bus button adds a Bus waveform to the Waveform view and opens the
Bus configuration menu.

■ If only one Bus waveform is displayed, pushing the button turns off the Bus waveform (removes it from Waveform
view).

■ If two Bus waveforms are displayed, pushing the button cycles through selecting each Bus waveform.
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■ The RF button adds the RF waveform on the Waveform view and switches from the time domain to the frequency
domain. All time domain waveforms are turned off and the spectrum analyzer is turned on. When you switch back to
the time domain, the time domain waveforms are restored.

■ The Digital button adds or selects a digital waveform on the Waveform view

■ If the digital channels are not displayed, pushing a Digital button turns on the channels in the Waveform view.
■ If the digital channels are on the screen, but not selected, pushing the Digital button selects the digital channels.
■ If the digital channels are on the screen and are also selected, pushing the Digital button turns the digital

channels off (removes them from Waveform view).

5. Horizontal controls:
 

 

■ Position moves the waveform from side to side on the screen (changing the trigger point position in the waveform
record). Push the knob to center the trigger event to the center of the graticule.

■ Scale sets the time per major horizontal graticule division and samples/second parameters for the oscilloscope. Scale
applies to all waveforms.

6. Miscellaneous controls:
 

 

■ Touch Off turns touchscreen capability off. The Touch Off button is lighted when the touchscreen is turned off.
■ Save is a one-push save operation that uses the current File > Save As settings to save screen shots (including open

menus and dialog boxes), waveform files, instrument settings, and so on, as follows:

■ If a File > Save or File > Save As operation has occurred since the last instrument startup, pushing Save saves
the file types to the location last set in the Save As configuration menu.

■ If no file save operation has occurred since the last instrument startup, pushing Save opens the Save As
configuration menu. Select a tab to select the type of file to save (Screen Capture, Waveform, and so on), set any
associated parameters, and where to save it, and select OK. The specified file or files are saved. The next time
you push Save, the same type of files are saved.

■ Screen Captures capture the entire screen, including displayed configuration menus and dialog boxes.
■ Default Setup restores the oscilloscope settings (horizontal, vertical, scale, position, and so on) to the default settings.

Default Setup does not change items found in the User Preferences menu.
■ Autoset automatically displays a stable waveform.
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7. Ground and Probe Compensation connectors:
 

 

■ The Ground and Probe Compensation connectors are located at the lower right side of the instrument, near the front
panel. The Ground connector (the small hole in the case) provides an electrically grounded (through a resistor)
connection point to attach an anti-static wrist strap to reduce electrostatic damage (ESD) while you handle or probe the
DUT.

■ The Probe Compensation connections provide a ground connector (upper tab) and 1 kHz square wave source (lower
tab) for adjusting the high-frequency response of a passive probe (probe compensation). The oscilloscope uses this
signal to automatically compensate supported probes, including the ones that ship with the product. See Compensate
TPP0250, TPP0500B, or TPP1000 probes on page 33.

8. USB Host ports (USB 2.0):
 

 

■ USB ports are located at the lower right corner of the front panel and on the rear panel. Connect USB flash drives to
which you can save or recall data (such as instrument software updates, waveforms, settings, and screen captures) or
connect peripheral devices such as a mouse or keyboard.
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9. Probe connectors:
 

 
■ Analog input connectors support all TekVPI+ and TekVPI measurement probes, BNC passive probes, the P6316 Logic

Probe, and BNC cables. See Connecting probes on page 5.

Rear panel connections
The rear panel connections supply power to the oscilloscope and provide connectors for network, USB devices, video, reference
signals, and the AFG output.
 

 
1. Power cord connector. Use only the power cord specified for this product and certified for the country of use.
2. AFG Out is the signal output for the optional Arbitrary Function Generator (AFG) feature.
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3. AUX Out generates a signal transition on a trigger event or outputs a synchronization signal from the AFG.

4. LAN connector (RJ-45) connects the oscilloscope to a 10/100 Base-T local area network.

5. USB Device port lets you connect to a PC to remotely control the oscilloscope using the USBTMC protocol.

6. USB Host port lets you connect a USB memory device, keyboard, or mouse.

7. HDMI output lets you connect an external monitor or projector to show the oscilloscope screen.

8. Security lock connector lets you use a standard PC/laptop lock cable to secure the oscilloscope to a work bench or other
location.

The user interface screen
The touchscreen user interface contains waveforms, measurement readouts, and touch-based controls to access all oscilloscope
functions.

1. The Menu bar provides menus for typical operations including:

■ Saving, loading, and accessing files
■ Setting oscilloscope display and measurement preferences
■ Configuring network access
■ Running self tests
■ Erasing measurement and settings memory (TekSecure™)
■ Loading option licenses
■ Opening a Help viewer

2. The Waveform View area displays analog, digital, math, reference, and bus waveforms. The waveforms include waveform
handles (identifiers), trigger position, and level(s) indicators. See Identifying items in the time domain display on page 17.
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3. The Results Bar contains controls for displaying cursors, adding result tables to the screen, and adding measurements to
the Results bar. The controls are:
■ The Cursors button displays on-screen cursors. Touch and drag or use the Multipurpose knobs to move the cursors.

Double-tap on a cursor or on the cursor readouts to open a configuration menu to set cursor types and related
functions.

■ The Measure button opens a configuration menu from which to select and add up to four measurements to the Results
bar. Each measurement you add has a separate badge. Double-tap a measurement badge to open its configuration
menu.

■ The Results Table button adds a Measurement, Bus, Search, and Harmonics results table to the screen. The Measure
tab displays all measurements present in the Results bar. The Bus tab displays bus decode information for displayed
bus waveforms. The Search tab displays search event information. The Harmonics tab displays harmonic
measurement results.

■ The Search button lets you detect and mark a waveform where specified events occur. Tap Search to open a Search
configuration menu and set the search conditions for analog and digital channels. Search badges are added to the
Results Bar.

■ The Measurement and Search badges show measurement and search results and are displayed in the Results Bar.
See Badges on page 22.

4. The Settings Bar contains System badges for setting Horizontal, Trigger, Acquisition, and Date/Time parameters; Inactive
Channel buttons to turn on channels; Math/Ref/Bus button to add math, reference, and bus waveforms to the display; and
Channel and Waveform badges that let you configure the individual waveform parameters. Tap a channel or waveform
button to add it to the screen and display a badge. Double-tap a badge to open its configuration menu. See Badges on
page 22.

5. Configuration Menus let you quickly change the parameters of the selected user interface item. You can open
configuration menus by double-tapping on badges, screen objects, or screen areas. See Configuration menus on page 27.

Identifying items in the time domain display
Each area of the user interface has a specific function that helps manage information or controls. This topic shows and describes
the key user interface elements.
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1. The Waveform Record View is a graphical high-level view of the overall acquisition, how much of the acquisition is on the
screen (shown in brackets), the location of key time events including the trigger event, and the current position of waveforms
cursors.
 

 

If you are changing the horizontal time scale while the oscilloscope acquisition is stopped, the brackets change position to
show the part of the waveform record that is being viewed relative to the current acquisition total record length.
 

 

If cursors are active on a waveform, the Waveform Record View shows the relative cursor positions as small vertical dashed
lines.
 

 

When in Zoom mode, the Waveform Record View is replaced with the Zoom Overview. See Zoom user interface elements
on page 28.

2. The Expansion Point icon on the waveform view shows the center point around which the waveform expands and
compresses when changing horizontal settings.
 

 

3. The Trigger Position Indicator shows where the trigger event occurred in the waveform record.
 

 

4. The Zoom icon (in upper right corner of Waveform and Plot views) toggles zoom on and off.
 

 

5. The Trigger Level Indicator icon(s) shows the trigger level(s) on the trigger source waveform. Some trigger types require two
trigger levels.

6. Measurement and Search badges show measurement and search results. See Badges on page 22.

7. The Results Bar Handle opens or closes the Results bar to maximize waveform screen viewing when needed. To reopen
the Results bar, either tap the handle icon or swipe left from the right side of the display.
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8. The System badges show global instrument settings (Horizontal, Trigger, Acquisition, Run/Stop status, and Date/Time).
See Badges on page 22.

9. The Inactive Channel buttons add channel waveforms to the Waveform view and add an associated Channel badge to the
Settings bar.

The Add Math Ref Bus button expands allowing you to add a math, reference, or bus waveform to the Waveform view and
add an associated Waveform badge to the Settings bar.

The RF button activates the frequency domain display and adds an RF badge. Double-tap the badge to open the RF
configuration menu to configure the RF input. This button is only active if one of the RF options is enabled.

The AFG button opens the AFG configuration menu to set and enable the AFG output. This button is only present if the
AFG option is installed.

The DVM button lets you use an analog probe to take DC, AC RMS, or DC+AC RMS voltage measurements on your DUT.
Tap the button to add a DVM badge to the Results Bar and open a configuration menu. The DVM option also enables a
trigger frequency counter, accessible from the Mode & Holdoff panel in the Trigger badge menu. This button is only
present if the DVM option is installed.

10. Double-tap a badge to open its associated configuration menu. See Badges on page 22. See Configuration menus on
page 27.

If you add more Channel or Waveform badges than can fit in the waveform badge display area, tap the scroll buttons at
each end of the waveform badge area to scroll and display hidden badges.

11. The Waveform Handles on each waveform identify the source of that waveform (Cx for channels, M for Math, Rx for
Reference waveforms, Bx for bus waveforms). The waveform handles are at the zero-volt level of the waveform by default.
The currently selected waveform handle is a solid color; unselected waveform handles are outlined.

Double-tapping a waveform handle opens the configuration menu for that waveform.

For digital channels, the waveform handle shows the channel number, with each individual digital signal labeled D0–D15
and displayed with a different color.
 

 

Double-tapping a digital waveform handle opens the digital channel configuration menu.
Dragging a digital signal handle over another handle swaps location of the signals in the waveform view. Dragging a digital
signal handle out of the group, creates a new group. A selected digital group or signal handle can be moved using the
Vertical Position control.
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Identifying items in the frequency domain display
This topic shows and describes each element of the frequency domain display.

To activate the frequency domain display, press the front panel RF button or tap the RF button in the display .

Each area of the user interface has a specific function that helps manage information or controls.

1. Vertical graticule labels

2. Start frequency

3. Reference level

4. Vertical scale

5. Center frequency

6. Span and resolution bandwidth

7. Stop frequency

8. Reference marker
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9. Displayed trace indicators

a. An RF trace indicator is placed at the Reference Level.

b. A capital M appears if the maximum trace is turned on.

c. A capital A appears if the average trace is turned on.

d. A capital N appears if the normal trace is turned on.

e. The small m appears if the minimum trace is turned on.

Orange highlighting indicates the currently selected trace. In the figures the small m, which stands for the minimum
trace, is highlighted. This indicates that the minimum trace is currently selected.

10. Normal trace: Each acquisition is discarded as new data is acquired.

11. Max hold trace: The maximum data values are accumulated over multiple acquisitions of the Normal trace.

12. Min hold trace: The minimum data values are accumulated over multiple acquisitions of the Normal trace.

13. Average trace: Data from the Normal trace is averaged over multiple acquisitions. This is true power averaging, which
occurs before the log conversion. Each power of 2 averaging reduces the displayed noise by 3 dB.
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Badges
Badges are rectangular icons that show waveform, measurement, and instrument settings or readouts. Badges also provide fast
access to configuration menus. The badge types are Channel, Waveform, Measurement, Search, and System.

Channel and Waveform badges
Channel and Waveform (Math, Ref, Bus) badges are shown in the Settings Bar, located along the bottom left of the screen.
Each waveform has its own badge. The badges show high-level settings for each displayed channel or waveform. Double-tap a
badge to open its configuration menu.
 

 

Most Channel and Waveform badges also have Vertical Scale buttons, shown by single-tapping the badge. Use these buttons to
increase or decrease the vertical scale setting for that waveform.
 

 

You can drag or flick Channel and Waveform badges down off the display to turn them off. Swiping back up from the bottom of
the display restores them if they were accidentally deleted.

Channel badges are listed in the channel order. For more information, double-tap the badge to open its configuration menu or
search the instrument Help.

Measurement badges
Result badges are located in the Results Bar. They show measurement or search results. The badge title also shows the
measurement source or sources. To add a Measurement badge, tap the Measure button, select a measurement, and tap Add.
 

 

Double-tap a Measurement badge to open its configuration menu to change or refine settings.
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Some measurements and their badges are only available as options. For example, Power measurements are only listed in the
Add Measurement menu if the PWR option is installed.
 

 

To add statistical readouts to individual measurement badges, double-tap a measurement badge to open its configuration menu
and select Show Statistics in Badge.
 

 

You can drag or flick Measurement badges off to the right of the display to delete them. You can bring the badge back by swiping
in from the right.

Search badges
Search badges are also shown in the Results Bar, below the Measurement badges. A search badge lists the search source,
search type, and the number of search event occurrences in the current acquisition. The instrument marks the waveform where
those events occur with small down-pointing triangles along the top of the waveform graticule. Double-tap a search badge to
open its configuration menu to change or refine search settings.
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Search badges are created by tapping the Search button. Use the displayed configuration menu to set the search criteria.

Search badges have < (Previous) and > (Next) Navigation buttons that open the Zoom mode and center the waveform in the
display at the position of the previous or next search mark in the waveform record. Search badge Navigation buttons are only
usable when acquisitions are stopped.
 

 

You can drag or flick a Search badge to the right, off the display, to delete it. You can bring the badge back by swiping in from the
right.

Signal clipping and badges
Clipping causes inaccurate amplitude-related measurement results. Clipping also causes inaccurate amplitude values in saved
waveform files. If a math waveform is clipped, it will not affect amplitude measurements on that math waveform.

WARNING. Clipping is caused by excessive or dangerous voltages at the probe tip and/or a vertical scale setting that is not
adequate to display the entire vertical range of the waveform. Excessive voltage at the probe tip can injure the operator and
cause damage to the probe and/or instrument.

This instrument shows a warning triangle symbol and the word Clipping in a Channel badge when a vertical clipping condition
exists. Any measurement badges associated with that channel also indicate a clipping condition.
 

 

To close the clipping message, change the vertical scale to show the entire waveform, disconnect the probe tip from the
excessive voltage source, and check that you are probing the correct signal using the correct probe.
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Error messages and badges
This instrument shows a warning triangle symbol and an error message abbreviation in a Channel badge when an error occurs.
 

 

To remove the message from the badge, clear the error.

System badges
System badges (in the Settings bar) display the main Horizontal, Trigger, and Acquisition settings. You cannot delete System
badges.
 

 

Double-tap a System badge to open its configuration menu.

The Horizontal badge also has Scale buttons, shown by single-tapping the badge. Use the Horizontal Scale buttons to increase
or decrease the horizontal time/div setting.
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Common badge actions

Action Result Example
Single tap Immediate access controls (Scale,

Navigation).
 

 
Double tap Configuration menu with access to

all settings for the badge.
 

 
Touch and hold Right-click menu with single tap

access to common actions. Typical
actions include turning off a
channel and deleting a
measurement or search badge.
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Configuration menus
Configuration menus let you quickly set the parameters for channels, system settings (Horizontal, Trigger, Acquisition),
measurements, cursor readouts, Waveform view, and so on.

Double-tap an item (badge, Waveform View, cursor readouts, and so on) to open its configuration menu. For example, double-
tap a Channel badge in the Settings Bar to open its configuration menu.
 

 

Selections or values that you enter take effect immediately. Menu contents are dynamic and can change depending on your
selections, instrument options, or attached probes.

Related settings are grouped into 'panels.' Tap the panel name to show those settings. Changes to panel settings can change
the values and/or fields shown in that panel and other panels.
 

 

Tap anywhere outside a configuration menu to close it.
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To open Help content for a configuration menu, tap the question mark icon in the upper right corner of the menu.

Zoom user interface elements
Use the zoom tools to magnify waveforms to view signal details.
 

 

1. The Zoom Overview shows the entire waveform record.

NOTE. Using pinch and expand gestures on the Zoom Overview waveforms changes the horizontal time base settings.

2. The Zoom Box shows the area of the Zoom Overview to display in the Zoom View (see  4). You can touch and drag the box
to move the area to view.

NOTE. Moving the Zoom Box or changing its position does not change the horizontal time base settings.

3. The Zoom icon (in the upper right corner of the Waveform View) switches zoom mode on and off.

4. The Zoom View shows the zoomed waveforms as marked by the Zoom Box. Use pinch and/or drag options in the zoom
view to change the zoomed area of interest.

NOTE. Pinch, expand, and drag gestures in the Zoom View only change zoom magnification settings and Zoom Box
position.

5. Use the Zoom Title Bar controls to adjust the horizontal size of the zoom area. Click or tap the + or - buttons.
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Using the touchscreen interface for common tasks
Use standard touchscreen actions, similar to those found on smart phones and tablets, to interact with most screen objects. You
can also use a mouse to interact with the UI. The equivalent mouse operation is shown for each touch operation.

See the table to quickly learn the fundamental touch operations.

 

Table 3: Common touchscreen UI tasks (with mouse equivalents)

Task Touchscreen UI action Mouse action
Add a channel, math, reference, or bus
waveform to the screen.

Tap an inactive channel button or the
Add Math Ref Bus button and select a
math, reference, or bus.

Click an inactive channel button or the
Add Math Ref Bus button and select a
math, reference, or bus.

Select a channel, math, reference, or bus
waveform to make it active.

Tap the Channel or Waveform badge or
waveform handle.

Click the Channel or Waveform badge or
waveform handle.

Display scale or navigation buttons on a
badge (waveform, measurement  1,
search, horizontal).

Tap the badge. Click the badge.

Open a configuration menu on any item
(all badges, views, cursor readouts,
labels, and so on).

Double-tap the badge, view, or other
object.

Double-click the badge, view, or other
object.

Open a right-click menu (badges, views). Touch and hold on the badge, Waveform
View, or other screen item until a menu
opens.

Right-click the object.

Close a configuration menu  2. Tap anywhere outside the menu or
dialog.

Click anywhere outside the menu or
dialog.

Move a menu. Touch and hold the menu title bar or a
blank area in the menu, then drag the
menu to new position.

Click and hold the left mouse button on
title or blank area and then drag to new
position.

Change horizontal or vertical settings
directly on a waveform.
Vertical changes only apply to the
selected channel or waveform; horizontal
changes apply to all channels and
waveforms.

Tap a badge and use the Scale buttons.
Or, use pinch/expand gestures.

Click a channel, waveform, or Horizontal
badge and click on the Scale buttons.

Increase or decrease the zoom area
(while in Zoom mode).

Touch and hold two fingertips on the
waveform view, move them together or
apart vertically or horizontally, lift from
screen, and repeat.

Click the + or - buttons on the Zoom Title
bar.

Quickly scroll or pan a waveform. Touch and drag in the waveform. Click and drag in the waveform or list.
Close or open the Results Bar to
increase the Waveform View area.

Tap on the Results Bar Handle or
anywhere in the border between the
Waveform View and the Results Bar.

Click the Results Bar Handle or
anywhere in the border between the
Waveform View and the Results Bar.
Click and drag the Results Bar divider.

1 Not all measurement or search badges display navigation buttons.
2 Some dialog boxes will not close until you click an OK, Close, or other button in the dialog.
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Configure the instrument

Set the date and time
Set the date and time so that saved files are marked with the correct date and time information.

1. Double-tap the Date/Time badge (bottom-right of screen) to open the configuration menu.
 

 

2. To turn off showing the date and time on the screen, tap the Display button to Off.
To turn on date/time display again, double-tap in the blank area where the date/time badge was displayed to open the
configuration menu and set the Display button to On.

3. You may also tap the Year, Day, Hour, Minute, or UTC Offset fields and use the multipurpose knobs to set the fields to the
correct time.
You may also double-tap the fields and use the numeric keypad to set the time.

4. Tap Month and select the month from the list.

5. Tap anywhere outside of the menu to close it.
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Download and install the latest firmware
Installing the latest firmware helps ensure that your instrument is equipped with all of the best available measurement and
analysis improvements.

Prerequisite: Save any important on-instrument files (waveforms, screen captures, oscilloscope setups, and so on) to a USB
drive or network. The installation process does not remove user-created files, but it is a good idea to back up important files
before an update.

Update oscilloscope firmware from a USB drive
Prerequisite: Determine the current version of firmware installed on the oscilloscope (Help > About)

1. Open up a Web browser on a PC and go to www.tek.com/product-support.

2. Enter the oscilloscope model number in the search field and click Go.

3. Scroll down the screen and click the Software tab.

4. If the listed available firmware version is newer than what is on your oscilloscope, select and download that file to your PC.

5. Copy the firmware install file to a USB drive.

6. Insert the USB drive into any oscilloscope USB Host port:

7. Power off the oscilloscope and then power on the oscilloscope.

NOTE. Do not power off the oscilloscope or remove the USB flash drive until the oscilloscope finishes installing the
firmware. The oscilloscope displays a message when it is OK to turn off the oscilloscope.

The oscilloscopes detects the USB drive with the firmware file and starts the installation process. Follow on-screen
instructions to install the firmware.

8. When the firmware install is finished, remove the USB drive and restart the oscilloscope.

To confirm the firmware installation:

a. Tap Help > About in the Menu bar.

b. Verify that the firmware version number listed on the screen is the same version that you downloaded.

Run Signal Path Compensation (SPC)
Run SPC at regular intervals for best measurement accuracy. You should run SPC whenever the ambient (room) temperature
has changed by more than 5 °C (9 °F) or once a week if you use vertical scale settings of 5 mV/div or less.

Signal Path Compensation (SPC) corrects for DC level inaccuracies in the internal signal path caused by temperature variations
and/or long-term signal path drift. Failure to run SPC on a regular basis may result in the oscilloscope not meeting warranted
performance levels at low volts per division settings.

Prerequisite: Disconnect all probes and cables from the front-panel channel inputs and rear-panel signal connectors.

1. Power on and warm up the oscilloscope for at least 20 minutes.

2. Tap Utility > Calibration.

3. Tap Run SPC. The SPC Status readout shows Running while SPC is running. SPC can take several minutes per channel
to run, so wait until the SPC Status message changes to Pass before reconnecting probes and using the oscilloscope.
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4. Close the Calibration configuration dialog when SPC has completed.

5. If SPC fails, write down any error message text. Make sure that all probes and cables are disconnected and run SPC again.
If SPC still fails, contact Tektronix Customer Support.

Compensate TPP0250, TPP0500B, or TPP1000 probes
Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. The
oscilloscope can automatically test and store compensation values for TPP0250, TPP0500B and TPP1000 probes.

The oscilloscope stores the compensation values for each probe/channel combination and automatically recalls the
compensation values when you plug in the probe again. Probe compensation status is shown in the Probe Setup panel of the
Channel configuration menu.

■ If the Probe Compensation Status field displays Pass, the probe is compensated and ready for use.

■ If the Probe Compensation Status field displays Default, the attached probe has not been compensated and needs to have
this probe compensation procedure run.

■ If the Probe Compensation Status field displays Fail, the attached probe has failed the probe compensation procedure.
Reconnect the probe and run probe compensation again.

■ If there is no probe compensation status field shown in the panel, the oscilloscope cannot store compensation values for
that probe. See the oscilloscope Help for how to manually compensate passive probes not supported by the probe
compensation function.

■ Each compensation generates values for a specific probe and channel combination. If you want to use the probe on another
channel and desire to compensate the new probe-channel pair, you must run a new set of compensation steps.

■ Each channel can store compensation values for 10 individual probes. If you try to compensate an 11th probe on a channel,
the oscilloscope will delete the values for the least recently used probe and add the values for the new probe.

Use this procedure to compensate a TPP0250, TPP0500B, TPP1000, or other supported TPP-family probe that shows a Default
status when connected to the oscilloscope.

NOTE. A Default Setup does not delete probe compensation values. A factory calibration deletes all stored probe compensation
values.

Prerequisite: The oscilloscope must be powered on for at least 20 minutes before compensating a probe.

1. Connect a supported probe to an input channel.

2. Connect the probe tip and ground lead of the probe to the PROBE COMP terminals on the lower right of the oscilloscope
(see following image).

Figure 4: Probe Comp connections.
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Connect the probe tip to the 1 kHz source and the ground clip to the ground. For best results, remove any probe tip
accessories and hold the probe tip directly onto the 1 kHz connector.

NOTE. Connect only one probe at a time to the PROBE COMP terminals.

3. Turn off all channels.

4. Turn on the channel to which the probe is connected.

5. Push the front-panel Autoset button. The screen displays a square wave.

6. Double-tap the badge of the channel that you want to compensate.

7. Tap the Probe Setup panel.

If the Probe Compensation Status says Pass, the probe is already compensated for this channel. You can move the probe
to another channel and start again from step 1 or connect a different probe to this channel and start from step 1.

If the Probe Compensation Status says Default, continue with this procedure.

8. Tap Compensate Probe to open the Probe Compensation dialog.

9. Tap Compensate Probe to run the probe compensation.

10. The probe compensation is finished when the Probe Compensation Status displays Pass. Disconnect the probe tip and
ground from the PROBE COMP terminals.

11. Repeat these steps for each supported passive probe that you want to compensate for this channel.

12. Repeat these steps to compensate supported probes on other channels of the oscilloscope.

NOTE. For most accurate measurements, open the Probe Setup panel and verify the Probe Compensation Status is Pass
whenever you attach a probe to a channel.

NOTE. A probe compensation failure is most likely due to intermittent connection of the probe tip or ground connection
during the probe compensation operation. If a failure occurs, the oscilloscope will re-use the old probe compensation values
if they existed prior to the failed probe compensation operation.

Connect to a network (LAN)
Connecting to a network allows you to remotely access the instrument.

Work with your network administrator to obtain the required information to connect to your network (IP address, Gateway IP
address, Subnet Mask, DNS IP address, and so on).

1. Connect a CAT5 cable from the oscilloscope LAN connector to your network.

2. Select Utility > I/O on the menu bar to open the I/O configuration menu.

3. Tap the LAN panel
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4. Obtain or enter the network address information:

■ If your network is DHCP-enabled and the IP address field does not already show an address, tap Auto to obtain the IP
address information from the network. DHCP mode is the default mode.

■ If your network is not DHCP-enabled or you need a static (non-changing) IP address for this instrument, tap Manual
and enter the IP address and other values provided by your IT or system administrator resource.

5. Tap Test Connection to verify that the network connection is working. The LAN Status icon turns green when the
instrument successfully connects to your network. If you have problems connecting to your network, contact your system
administration resource for help.
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EMC safety and environmental compliance

Compliance information
This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies. This product is intended for use by professionals and trained personnel only; it is not designed for use in households or
by children.

Questions about the following compliance information may be directed to the following address:

Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

www.tek.com

EMC compliance

EU EMC Directive
Meets intent of Directive 2014/30/EU for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1, EN 61326-2-1. EMC requirements for electrical equipment for measurement, control, and laboratory use.  1 2 3 4

■ CISPR 11. Radiated and conducted emissions, Group 1, Class A

■ IEC 61000-4-2. Electrostatic discharge immunity

■ IEC 61000-4-3. RF electromagnetic field immunity

■ IEC 61000-4-4. Electrical fast transient / burst immunity

■ IEC 61000-4-5. Power line surge immunity

■ IEC 61000-4-6. Conducted RF immunity

■ IEC 61000-4-11. Voltage dips and interruptions immunity

EN 61000-3-2. AC power line harmonic emissions

EN 61000-3-3. Voltage changes, fluctuations, and flicker

1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
3 Equipment may not meet the immunity requirements of applicable listed standards when test leads and/or test probes are connected due to coupling of electromagnetic

interference onto those leads/probes. To minimize the influence of electromagnetic interference, minimize the loop area between the unshielded portions of signal and
associated return leads, and keep leads as far away as possible from electromagnetic disturbance sources. Twisting unshielded test leads together is an effective way to
reduce loop area. For probes, keep the ground return lead as short as possible and close to the probe body. Some probes have accessory probe tip adapters to
accomplish this most effectively. In all cases, observe all safety instructions for the probes or leads used.

4 For compliance with the EMC standards listed here, high quality shielded interface cables that incorporate low impedance connection between the cable shield and the
connector shell should be used.
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Australia / New Zealand Declaration of Conformity – EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

■ EN 61326-1 and EN 61326-2-1. Radiated and conducted emissions, Group 1, Class A.

Safety compliance
This section lists the safety standards with which the product complies and other safety compliance information.

EU declaration of conformity – low voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Union:

Low Voltage Directive 2014/35/EU.

■ EN 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General
Requirements.

■ EN 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

U.S. nationally recognized testing laboratory listing
■ UL 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General

Requirements.

■ UL 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

Canadian certification
■ CAN/CSA-C22.2 No. 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use

– Part 1: General Requirements.

Additional compliances
■ IEC 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1:

General Requirements.

■ IEC 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

Equipment type
Test and measuring equipment.

Safety class
Class 1 – grounded product.

Pollution degree description
A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment for
which they are rated.

■ Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

■ Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is caused
by condensation must be expected. This location is a typical office/home environment. Temporary condensation occurs only
when the product is out of service.
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■ Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

■ Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical outdoor
locations.

Pollution degree rating
Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor, dry location use only.

IP rating
IP20 (as defined in IEC 60529).

Measurement and overvoltage category descriptions
Measurement terminals on this product may be rated for measuring mains voltages from one or more of the following categories
(see specific ratings marked on the product and in the manual).

■ Measurement Category II. For measurements performed on circuits directly connected to the low-voltage installation.
■ Measurement Category III. For measurements performed in the building installation.
■ Measurement Category IV. For measurements performed at the source of low-voltage installation.

NOTE. Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a measurement
category rating. Other circuits within the product do not have either rating.

Mains overvoltage category rating
Overvoltage Category II (as defined in IEC 61010-1)

Environmental compliance
This section provides information about the environmental impact of the product.

Restriction of hazardous substances
Complies with RoHS2 Directive 2011/65/EU.

Product end-of-life handling
Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the product’s end of life.
To avoid release of such substances into the environment and to reduce the use of natural resources, we encourage you to
recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according to
Directives 2012/19/EU and 2006/66/EC on waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Tektronix Web site (www.tek.com/productrecycling).

Perchlorate materials. This product contains one or more type CR lithium batteries. According to the state of California, CR
lithium batteries are classified as perchlorate materials and require special handling. See www.dtsc.ca.gov/hazardouswaste/
perchlorate for additional information.
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Index
A
A knob, 9
Acquisition controls, 9
Add

Bus waveform button, 17
Math waveform button, 17
Ref waveform button, 17

add measurement statistical readouts to badge, 22–26
AFG

option, 17
AFG Out (rear panel), 15
automatic probe compensation (TPP250, TPP0500B,

TPP1000), 33
Autoset

button, 9
AUX Out

rear panel, 15
avoid pinching when rotate handle, 1

B
B knob, 9
badge types, 22–26
badges, 22–26
Bus button, 9

C
cable lock, 15
channel badge, 22–26
Channel buttons (front panel), 9
Clear button, 9
clipping message, 22–26
common touchscreen UI tasks, 29
compensate TPP250, TPP0500B, TPP1000 probes, 33
configuration menus, 27
connect lock cable, 3
connect to a network, 34
connecting probes, 5
correct handle rotate, 1
Cursors button, 9
Cursors button (touchscreen), 16

D
Default Setup button, 9

DVM option, 17
dynamic range limit marker, 17

E
e*Scope, 7
Environment requirements, 2
errors, 24
Ethernet port (rear panel), 15
Ethernet, connect to, 34
expansion point, waveform, 17

F
Fast Acq button, 9
firmware, how to update, 32
Force button, 9
frequency domain display, 20
front panel

Acquisition, 9
Autoset button, 9
Bus button (front panel), 9
Channel buttons (front panel), 9
Clear button, 9
Cursors button, 9
Default Setup, 9
description, 9
Fast Acq button, 9
Force button, 9
High Res button, 9
Horizontal, 9
input connectors, 9
Level knob, 9
Math button (front panel), 9
Mode button, 9
multipurpose knobs, 9

position
knob (horizontal), 9

Position knob, 9
probe compensation connectors, 9
Ref button (front panel), 9
Run/Stop button, 9
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Scale knob, 9
Scale knob (horizontal), 9
Single/Seq button, 9
Slope button, 9
Touch Off button, 9
Trigger, 9
USB ports, 9
Vertical, 9

G
GPIB talk/listen address, 7

H
handle rotate, 1
handles, analog and digital, 17
HDMI output (rear panel), 15
High Res button, 9
Horizontal controls, 9
how to

check power-on self tests results, 5
compensate TPP250, TPP0500B, TPP1000 probes, 33
connect probes, 5
connect to network, 34
connect to PC using USB cable, 7
download, install firmware, 32
remote access the oscilloscope (from Web), 7
run signal path compensation (SPC), 32
set GPIB talk/listen address, 7
set time, 31
update firmware, 32
use mouse with the UI, 29

I
inactive channel buttons, 17
Input connectors (front panel), 9
input signal level requirements, 2

K
knob A, 9
knob B, 9

L
LAN port (rear panel), 15

LAN, connect to, 34
Level knob, 9
lock to bench or rack, 3
LXI, 7

M
Math button, 9
Measure button, 16
measurement badge, 22–26
Menu bar, 16
menu panels, 27
menus, 27
Mode button (front panel), 9
mouse touchscreen UI equivalents, 29
multipurpose knobs, 9

N
navigation buttons, badges, 22–26
network, connect to, 34

O
operating

altitude range, 2
humidity range, 2
temperature range, 2

operating power requirements, 2

P
panels, menu, 27
pinching and handle rotate, 1
position

knob, 9
knob (horizontal), 9

power cord connector (rear panel), 15
power requirements, 2
power standby mode, 4
power-on test results, 5
powering on or off, 4
probe

compensation (TPP0500B, TPP1000), 33
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compensation connectors, 9
compensation TPP250, 33
errors, 24
inputs, 9

probes, connecting, 5
proper handle rotate, 1

R
rack mount kit information, 6
rear panel

AFG Out, 15
AUX Out, 15
cable lock, 15
connections, 15
Ethernet port (RJ-45), 15
HDMI output, 15
LAN port (RJ-45), 15
power cord, 15
security cable lock, 15
USB Device port, 15
USB Host ports, 15

record view, waveform, 17
Ref button, 9
related documents, viii
remote access (e*Scope), 7
remote access (Web-based), 7
remove AC power from instrument, 4
requirements

altitude, 2
environment, 2
humidity, 2
power, 2
signal inputs, 2
temperature, 2

Results bar, 16
Results Table button, 16
RF, 20
RM3 rack mount, 6
run signal path compensation, 32
Run/Stop button, 9

S
Save button, 9

scale buttons, badge, 22–26
Scale knob, 9
Scale knob (horizontal), 9
search badge, 22–26
Search button, 16
security cable lock, 15
set

GPIB talk/listen address, 7
time, 31

Settings bar, 16
signal input levels, 2
Single/Seq button, 9
Slope button (front panel), 9
SPC (signal path compensation), 32
standard accessories, 1

T
TekVPI input connectors, 9
time, how to set, 31
Touch Off button, 9
touchscreen UI tasks, 29
trigger

level indicators, 17
position indicator, 17

Trigger controls, 9
turn instrument on or off, 4

U
USB cable, connect to PC, 7
USB Device port (rear panel), 15
USB Host ports (rear panel), 15
USB ports (front panel), 9
using mouse with the touchscreen, 29

V
Vertical controls, 9

W
waveform

expansion point, 17
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record view, 17
waveform badge, 22–26
Waveform View, 16

Z
Zoom box, 28

zoom icon, 17
Zoom overview, 28
Zoom title bar, 28
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